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New 2D Workspace
If you are using only 2D AutoCAD® LT commands, 
why not use the new 2D Drafting & Annotation 
workspace? This capability displays powerful 
2D tools on the Dashboard.

2D Dashboard Control Panels
New 2D control panels provide easy access  
to layers and include controls for annotation 
scaling, text, dimensions, multiple leaders, 
tables, 2D navigation commands, object 
properties and block attributes.
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Tool Palettes 
When you drag geometry to an inactive 
tool palette, it is automatically activated 
for easy placement – just give it an extra 
second to switch.

•	 A new Specify Image option on the 
shortcut menu makes it easy to assign  
an image to any tool.

•	 The location of tools on a tool palette is 
now saved in the tool catalogue (and the 
profile), making it easier to share your 
tool palettes with others and maintain 
the same look and feel.

•	 Use TPNAVIGATE to set a tool palette 
current at the command line.

Clean Screen
Use the Clean Screen button located in the 
lower-right corner of the screen to turn off 
everything except for the status and menu 
bars and the command window. This feature 
comes in handy when showing files to a client 
and you need to quickly clean up your 
interface.
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Controlling Toolbar  
and Tool Palette Placement
Anchor your palettes to the left or right side 
of the drawing area for quick access. Palettes 
roll open or closed as the cursor moves over 
them, keeping them out of the way. You can 
easily stack several on each side of the screen 
for maximum productivity. Simply right-click 
the name bar and choose Anchor Left or 
Anchor Right from the shortcut menu.

 

Layout Tab Improvements
•	 Rename a layout by double-clicking the 

Layout tab. 
•	 Re-order layouts with a simple drag-

and-drop.
•	 Use the Ctrl and Shift keys to select 

multiple layouts for dragging and 
dropping.

•	 Hold down Ctrl while dragging to create 
a copy.
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�Annotation Scaling

If you’ve found getting the proper scale factors 
per viewport to be frustrating and confusing, 
then you’ll love the new annotative scaling!  
No longer do you need to create multiple sets 
of text and dimensions on multiple layers.  
Now you create one set of annotative objects 
(such as text, dimensions, multiple leaders, 
blocks, attributes and hatches), indicate the 
desired actual plotted size and it magically 
displays at the correct size.

Controlling Annotation Scale
A new annotative property can be assigned to 
objects such as text, dimensions, blocks and 
hatches. Just create the object at the actual 
size you want it to plot and indicate the 
intended scale factor(s). Any object with an 
annotative property can have one or more 
scales assigned to it (such as ¼”=1’ or 1:50). 
This capability makes it easy to display the 
same object in different viewports with 
varying scale factors. For example, the same 
text object could appear in one viewport that 
is scaled 1/8” = 1’ and another viewport at 1”=1’.

You can change an existing object to 
annotative using the Properties command. 

 Re-defining a style or definition to be 
annotative does not affect existing objects. 
Use the new ANNOUPDATE command to 
update selected objects to match their style 
or definition (model space only).
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How can you tell if an object is annotative 
just by looking at it? Drag your cursor over 
the object to see the new annotative 
indicator.

 

 Set the annotative scale factor in model 
space to reflect the most prevalent scale 
factor in the drawing. 

For those objects that need to display at 
multiple scale factors, use the Properties 
palette to add scale factors. You can also  
use the OBJECTSCALE command. 

 It’s faster to use the OBJECTSCALE 
command when dealing with different  
object types.

New Annotative Controls  
on the Status Bar
•	 Use the two new controls on the status 

bar to set the VP Scale and Annotation 
Scale (accessible only if the viewport  
is unlocked). 

•	 A new Lock/Unlock Viewport button 
appears when a viewport is selected.

•	 Only the annotative objects that have  
the same scale factor as the viewport 
appear in a viewport. Toggle the new 
Annotation Visibility button to display 
annotative objects for all scales (even if 
they are not supported by the viewport’s 
current annotation scale).

 Use SCALELISTEDIT to customise  
the list of scales.

 If an annotative object disappears 
(and you don’t want it to), click the 
Automatically Add Scales to Annotative 
Objects button before changing the 
Annotation Scale. 
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Backward Compatibility
A new option on the Open and Save tab of 
the Options command helps ensure that 
those who are not using AutoCAD® LT 2008 
can see your annotative objects. Each scale of 
the objects is saved as an independent object 
on its own layer. The layers are automatically 
frozen in the appropriate viewport.

 If you have a large quantity of 
annotative objects, you can speed things 
up by turning off the Maintain Visual 
Fidelity option. Be sure to turn it back  
on before you save the file to a previous 
version!

 Linetypes are automatically 
scaled by the viewport’s annotation 
scale. Disable this behaviour with the 
MSLTSCALE setvar if needed.
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New Multiple Leaders
The new MLEADER command permits more 
control over leaders than ever before.  
Not only can you control the order of leader 
creation (head first, tail first or content first), 
but you can also add multiple leader lines 
where needed.
 

New Multiple Leader Style Manager
The new MLEADERSTYLE command controls 
format and display options, just like 
dimension styles. New options include the 
following:
•	 Type of leader line (straight, spline or none)
•	 Type of arrowhead
•	 Leader connection info
•	 Text information
•	 Assign a block (great for creating balloons!)

 

Dimensioning Techniques 

 Use the shortcut menu to add leader 
lines. Use grips for speedy editing.

Aligning Leader Lines
Leaders not lining up properly? The new 
Multiple Leader Align tool snaps leaders  
into place for you. You can even control the 
spacing between them!

Use the MLEADERCOLLECT command to 
combine multiple block-type leaders into  
a single multiple leader. 
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Smart Dimension Break Command
The new DIMBREAK command breaks 
dimension or extension lines where they 
intersect objects or other dimensions.  
The breaks automatically update if you move 
the intersecting objects – even if they no 
longer intersect! You can also use the Restore 
option to remove all breaks.

More Cool Dimension Features:
•	 Create inspection dimensions with the new 

Inspection Dimension tool (DIMINSPECT). 
•	 Add a jog to linear dimensions with the 

DIMJOGLINE command.
•	 Evenly space dimensions with the 

DIMSPACE command.
•	 Dimension an arc beyond its endpoints 

with the updated diameter and radial 
dimension commands.

•	 Place the dimension text outside the 
angle being measured with the updated 
Angular Dimension command.

•	 The new Tolerance alignment option in 
the Dimension Style dialogue box allows 
you to align decimal separators or 
operational symbols.
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Text Step Savers
Use these handy tricks to buy yourself  
some time when working with text in 
AutoCAD LT 2008.

MTEXT Column Wrap
Ever wish text would automatically wrap 
across multiple columns in wide areas of your 
drawing? Your wish has been granted with the 
new dynamic columns option in the MTEXT 
command. Use grips along with the text 
formatting ruler to get the exact results  
you are after. 

Step Savers 

More Control over Paragraphs
The updated MTEXT command permits  
more control over paragraph alignment, 
indentations and spacing. 
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More Efficient Spell Checker
No need to select objects first. The updated 
spell checker searches the entire drawing  
by default. You can also specify the current 
space or specific objects if you prefer. When 
an error is found, AutoCAD LT now highlights 
and zooms to the word in the drawing.

The new Check Spelling Settings dialogue box 
allows you to customise the spell checker.  
You can choose to include dimension text, 
attributes and xrefs and set a variety of 
exclusions, such as capitalised words or  
words with numbers.

Create Attributes  
with Multiple Lines of Text
The new Multiple Lines option allows you 
to create attributes that support multiple 
lines, underlining, overlining, fields and  
so forth. 
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Table Step Savers
Improved capabilities in AutoCAD LT 2008  
take away the pain when you’re working  
with tables.

Bidirectional Excel Tables
Wouldn’t it be nice if you could bring a 
Microsoft® Excel® file into AutoCAD LT and 
truly link the file? If you could change the 
Excel file and have it update in AutoCAD LT 
and vice versa? Good times are here at last, 
because now you can do exactly that! 

Just use the updated Paste Special command, 
choose AutoCAD Entities and select Paste 
Link to insert the Excel spreadsheet into 
AutoCAD LT. This process creates a data link. 
Should any changes occur in the XLS file,  
a bubble notification lets you know that the 
data link has changed and provides an easy 
option to update the table. 

Create a Table from a Data Link
A new option in the TABLE command also 
allows you to create a table from an Excel file. 
Just select all or part of the sheet. 

Retain Changes in Tables
Any changes you make to an AutoCAD LT 
table are retained, even if you update the 
table to reflect any changes in the Excel file!

 Use the DATALINK command to manage 
all of your various data links.

Wrap Long Tables Across Multiple Rows
To wrap tables across rows, simply select the 
table and adjust it with grips or use the new 
Table Break tool in the Properties palette.
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Create Incremental Data Fast
New auto-fill allows you to quickly increment 
data in cells by dragging, just as in Excel.  
You can also combine blocks and text in the 
same cell!

View New Grip Tips on Dynamic Blocks
As you hover the cursor over a dynamic block 
grip, the associated parameter description 
displays as a tooltip.

Recover Drawings Along with Xrefs
A new drawing utility allows you to run 
the recover process on a drawing and all 
the associated xrefs. Find this capability 
under Files>Drawing Utilities or use the 
RECOVERALL command.

Change Copy Multiple Default
To default to a single copy, set the system 
variable COPYMODE to 1. Step Savers
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The Layer command is the third most frequently 
used command in AutoCAD LT. These additions 
make this popular command even better!

Customise the Layer Manager
Now you control the display order of the layer 
property columns by dragging the column 
headings—put your favorites on the left for 
easy access. Too many columns? Turn off the 
ones you aren’t using by choosing Customise 
from the shortcut menu.

Freezing a Layer in All Viewports
The shortcut menu allows you to create a new 
layer that is frozen in all viewports, a function 
that is also available as a new button. Here 
you also find additional controls to freeze or 
thaw the selected layer(s) in all viewports. 
 

Renaming Layers
There are now three ways to rename a layer. 
Double-click the layer name, select a layer 
and press F2 or choose Rename from the 
shortcut menu.
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Layers

Layer Properties per Viewport
How often have you wished you could assign 
layer properties per viewport? Wish granted! 
No more tedium duplicating geometry on 
separate layers and flipping the layers on 
and off per viewport. Now you can double-
click in a viewport and assign a specific 
colour, linetype, lineweight and plotstyle per 
layer that affect only the current viewport. 
(Hoorah!)  

 

Remove these viewport overrides from the 
right-click menu. Use VPLAYEROVERRIDES-
MODE (phew!) to temporarily ignore the 
overrides for viewing or plotting. These 
overrides affect only those objects that are 
bylayer. Use the new SETBYLAYER command 
to quickly change objects to bylayer, including 
those within blocks and nested blocks!

Direct Access  
to the Layer States Manager
A new LAYERSTATE command (LAS 
alias) provides access to the Layer 
State Manager from the command 
prompt (also on the layer panel of the 
Dashboard). Use the new Import option 
to bring in layer states directly from 
DWG™, DWT or DWS files. Now you can 
also edit or view layer states from xrefs!



16

New Layer Evaluation Tool
A new Settings button in the Layer command 
allows you to turn on a new layer evaluation 
tool. 
•	 The first time you save or plot, the current 

list of layers is stored for evaluation 
purposes.

•	 When new layers are added, an “Unrecon-
ciled New Layers” notification appears. 
Click the link to view the non-matching 
layers.

•	 A new layer filter for unreconciled layers  
is automatically created.

•	 Layer Settings allows you to customise  
this process.

•	 Two new system variables, LAYEREVAL  
and LAYERNOTIFY, are now available.

New Layer Panel on the Dashboard
The new Layer panel provides quick access  
to all these cool new tools, including the very 
popular Layer Isolate (LAYISO) and Layer 
Unisolate (LAYUNISO) commands! New 
fading options allow you to lock and fade 
background layers, rather than hiding them 
completely.
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New CUI Features
Now you can customise the Dashboard and 
palettes with all your favorite commands in 
the CUI command. Simply drag a command 
from the command list directly to the palette. 
Customise the Dashboard by dragging 
commands to the new Dashboard panel  
that displays in the upper right of the CUI. 
You can even create a new row of tools on  
the Dashboard by dragging a toolbar from  
the Toolbar node to the Dashboard node.

A new search tool makes it easy to find 
commands. The macro associated with each 
command appears as a tooltip as you hover 
the cursor over the command. 

New Dynamic Preview Panel
It’s easy to drag Dashboard and toolbar tools 
to the Preview Panel in the CUI. 

New Quick CUI
The QUICKCUI command displays a simplified 
Customise User Interface dialogue box for 
speedy customisation. Just drag commands  
to toolbars or palettes.

Double-Clicking
When you double-click an object, a command 
is launched. Now you can assign which 
command is executed for each type of object! 
For example, when you double-click an 
attribute definition, the DDEDIT command 
is executed, allowing you to edit only the 
attribute value.
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Sharing your drawing information is important 
and AutoCAD LT 2008 makes it even easier  
to do so.

Using DWF Files as Underlays
The DWFATTACH command enables you to 
use a DWF™ file as an underlay, just as you 
can with raster images. The DWF file is linked 
and not physically embedded into the 
drawing file, thus keeping the file size down. 
You can snap to an attached DWF file and 
adjust the fade, contrast and monochrome 
from the Properties palette or DWFADJUST 
command. Use the shortcut menu to clip the 
DWF file and control the layer visibility of  
a selected DWF file.

 

Working with DGN files
Now you can attach Bentley MicroStation® 
V8 DGN files to your AutoCAD LT drawings  
or export DWG files to V8 DGN format using 
File>Export. Bring them in as externally 
referenced underlays with DGNATTACH 
using Insert>DGN Underlay. Clip the DGN 
from the shortcut menu (or use DGNCLIP) 
and use Properties to adjust contrast, fade 
and monochrome (or DGNADJUST). 

Import V8 DGN data with DGNIMPORT using 
File>Import. When importing, a dialogue box 
prompts for information regarding external 
DGN references, text nodes and units to help 
you get the best results.
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Share

External References
Now you can use the XREF command to see all 
externally referenced files in one handy central 
location. Here you find any attached drawing 
files, DWF files, images and DGN files.
 

Plotting to PDF
Use the Add Plotter wizard to print your  
drawings to PDF format. Under Manufacturers, 
select Autodesk ePlot (PDF) and under 
Models select PDF.

 

Access to DWG Files
AutoCAD LT 2008 lets you open DWG files 
all the way back to AutoCAD version 2.0 
and AutoCAD LT version 1.0 (ancient!). 

•	� Backward and forward conversion  
of DWG files from AutoCAD LT 97 to 
AutoCAD LT 2008 using the conversion 
features of DWG TrueView™ 2008 
software.

•	� Now anyone can view, publish and plot 
DWG files with DWG TrueView. 

Download DWG TrueView for free (and we 
all love free!) at www.autodesk.com/dwg.

 Use DWG TrueView to quickly apply a 
page setup to multiple layouts!
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Lynn Allen, Cadalyst columnist and worldwide 
Autodesk Technical Evangelist, speaks to 
more than 30,000 users each year. For the 
past fourteen years she has written a monthly 
column in Cadalyst magasine called “Circles 
and Lines.” Lynn started using AutoCAD® 
software with Release 1.4, over 20 years ago 
and has taught at the corporate and collegiate 
level for 13 years. A sought-after public 
speaker with a unique comedic style, Lynn is 
consistently one of the highest rated speakers 
at Autodesk University. Her latest book  
is entitled AutoCAD Professional Tips  
and Techniques. 

To purchase AutoCAD LT 2008 software,  
visit www.autodesk.co.uk/autocadltbuy. 
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